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Unit II - Creating ProjectsIntroduction

Preface

Just as the Industrial revolution during the 20th

century replaced agrarian ways, new models and

tools must be adopted as the 21st century ushers in

the “Age of Knowledge.” To be effective, teachers

need to do more than merely lecture and must be

able to provide more meaningful and fun instruction

for their students. Our tutorial is designed to help! In

less than two hours teachers and students will be able

to become acquainted and feel comfortable with an

easy to use authoring program called HyperStudio, a

medium tailored for our new millenium.

What is HyperStudio?

“HyperStudio allows anyone to create multimedia

programs. The tools are simple enough for primary

school kids... but they combine enough power and

flexibility to make them suitable for adult users.

Whether you want to create simple projects... or a

professional presentation for an adult audience,

everything you need is at your fingertips.” -

Computer Living, Australia

HyperStudio is versatile. It has already been

established as a popular authoring software in the K-

12 schools around the nation. In fact, it is used by

more than one million K-12 students, as well as

commercial developers. Roger Wagner, who had

been previously teaching math and science at a San

Diego school, founded the company in 1978,

currently making it one of the oldest software

companies in the country. Virtually any multimedia

element whether its a graphic, movie, or sound, etc.

can be added to a project in seconds. The application

is cross-platform and with the latest upgrade to 3.0, a

HyperStudio stack can be viewed via a browser and

plug-in over the Internet.

Who may be interested in our tutorial?

• Teachers who are not acquainted with this

program may want to review the tutorial to see

why this is popular software program.

• Any student from the age of 10 onward, who is

unfamiliar with HyperStudio may want to use this

quick and easy way to become acquainted with

the application and its potential.

• Teachers already familiar with HyperStudio may

also want to review the mini-course as an

example of how to incorporate HyperStudio into

their curriculum. (Note: This tutorial is designed

with special consideration for both Science and

English as a Second Language instruction, as

well as multiple learning styles.)
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How can you use the mini-course?

The mini-course is flexible. It’s divided into two

units so that you can adapt it to your needs. The

first unit is strictly a tutorial illustrating the most

elementary aspects in order to help you create your

first couple of stacks. Unit 2 is more advanced

introducing special effects that can be achieved

with the use of interactive buttons. The appendix

includes a helpful glossary, as well as, a set of

design and instructional criteria for producing a

multimedia project.. Presented together, the

introduction to HyperStudio tutorial can be easily

adapted to a day long workshop for students and

teachers..

What are the system requirements?

No matter how careful you are in buying a

computer, a more powerful computer with more

storage capacity is around the corner. Most of the

computers in use today, however, were purchased

before multimedia capabilities became popular. Like

most, you may have to upgrade where needed. The

following are general guidelines that will enable you

to capture, edit, and play sound and video. You can

add or substract from the following list to adapt to

your computer's configuration. A salesperson from a

reputable computer store can help you regarding this.

One thing is for sure, you can't have enough RAM

and the price has dropped in this area considerably.

For Windows, you'll need:

• 386 processor or higher

• 6 Mb at least

• MPC-2 compliant CD-ROM drive recommended

• Windows 3.1 or higher; DOS 5.1 or higher

• 256 colors required in Windows

• Sound Blaster or Windows sound system

• Compatible sound card

• Image capture requires video digitizer, digital

camera or TWAIN-compatible device

• Sound support: WAV sound files

• Digital Movie Support: QuickTime and AVI movies

• Graphics Support: BMP, PCX, JPG, TIF, TGA, and

PICT.

For the Macintosh, you'll need:

• 68020 processor or higher; System 6.0.7 or higher

• 6 Mb  at least

• CD-ROM drive

• QuickTime 1.5 or higher

• Image capture requires video digitizer or digital

camera

• Color monitor recommended

• Sound Support: AIFF, AIFC, SND1, SND2, MOD,

System 7, WAV and QuickTime sound files.

• Graphics support: PICT, TIFF, EPS, JPEG, GIF,

PCX, BMP, MacPaint, and Photo-CD

• Digital Movie Support
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Who created the tutorial?

The tutorial is result of an evolution of events. An

ESL instructor, Carol Barney, currently with the

Shawnee Mission school district, developed the

original lesson plan. The layout and editing of the

content  was handled by Karen Lynne Sorensen,

Internet Projects Manager at Johnson County

Wastewater.

 The final “mini-course” is a practical guide for you

to use in whichever manner you like: as a stand alone

presentation where you can interact one-on-one with

the computer at anytime, or as a stand along

presentation in a classroom or workshop setting.

Introduction
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Appendix 5: Objectives Schematic ............................................................................................................... 71

Objectives

Goal: To clarify what HyperStudio is, who uses it, and for what purposes.

Objectives: • To describe HyperStudio to others.
• To acknowledge how HyperStudio can benefit you.
• To identify the basic steps needed to create a HyperStudio stack.
• To identify five advanced features accomplished with interactive buttons.

Activities: • Discover why HyperStudio was created and what the application is all
about.

• Learn how you can benefit from using HyperStudio.
• Hands-on: working either alone or with a partner, go through a tutorial

introducing you to its basic and advanced features.
• Explore some HyperStudio stacks.

Refer to Appendix for a schematic of objectives.
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Pretest /
Post test

1. HyperStudio is a multimedia tool that
lets people create new ways to retrieve,
________, customize, and deliver
information; skills that are becoming as
fundamental as word processing.

2. HyperStudio was created to provide
users with a ____ that gives them new
ways to quickly and easily access,
organize, and create large bodies of
information such as the information now
available on CD-ROM and the Internet.

3. HyperStudio was created to provide
__________ experts with a way to
distribute their knowledge to others.

4. HyperStudio was created to provide
________ with at tool that can integrate
text, graphics, sound, animation, and
video.

5. When you open HyperStudio the first
card you see is the ________. The icons
on this card are buttons that access the

stacks pictured.
6. HyperStudio presents information in

______, just like index cards. Cards can
contain both text and graphics. Cards
are organized into stacks. Each stack
contains several cards of related
information. A card is always the same
size.

7. Links enable you to __________ any
piece of information on one card to any
other card or media element. You link
cards to organize information in
whatever way is most useful to you. To
move from one card to another, you
click on buttons.

8. At the top of the HyperStudio
application is a set of “pull-down”
menus. The “Edit menu” has an  _____
command that gives you an opportunity
to undo your last action. You'll also use
the “Edit menu” in other ways such as
for cutting and pasting. The “Go menu”
enables you to navigate among cards.

9. HyperStudio skills fall into two major
categories:  _______ and authoring. The
hand tool indicates you are in the
browsing mode enabling you to access
information but not change it. The
pointer indicates you are in an authoring
mode enabling the creator to interact
with the application, adding and

updating information, creating buttons,
and linking cards.

10. HyperStudio is beneficial to use because
it is one of the most powerful products
available for  _________  and
distribution of text, graphics, sound, and
video. It lets you organize information
by nonlinear association and context in
addition to linear hierarchical fashion.

ANSWERS

1. organize (acceptable: design,
coordination)

2. tool (acceptable: option, alternative)
3. subject-matter (acceptable: content,

topic)
 4. developers (acceptable: creators, users)
5. “Home Card”
6. cards
7. connect
8. Undo
9. browsing (acceptable: browse,

navigating)
10. integration (acceptable: creation,

production)
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Unit 1 “Advanced Organizer”

Unit 1 will help you become familar with the fundamentals of the HyperStudio application

and how to create a simple project. Most of the new concepts that are introduced will have

accompanying illustrations. By the end of the unit you will have advanced to creating a stack

of three cards.

This will prepare you for Unit 2 in which  you'll gain further experience creating various

kinds of buttons and the special effects you can achieve.

Note: This tutorial serves as a brief introduction to becoming acquainted with the program

and producing your first stacks. For more information ranging from using keyboard shortcuts

to creating animation and using Hyperlogo, HyperStudio's programming language, please

refer to the HyperStudio manual that accompanies the application.

In addition, there are many other references and resources available. HyperStudio, for

example, offers a free working demo of their latest 3.0 version that also includes a tutorial.

Please visit the HyperStudio web site, http://www.hyperstudio.com to obtain more

information about their free CD and additional resources.

One final word for those using this tutorial in a workshop setting, please don't hesitiate and

ask if you need assistance with the lesson plans or equipment. Thanks!
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Lesson 1 In this lesson you will create a card, containing a colored background, border,

and title. (Buttons for navigating will be added in Lesson 4.)

Upon completion of this lesson you
will be able to:

• Start a new stack.
• Select “Preferences.”
• Customize your card's dimensions.
• Save and name a stack.
• Create a tools palette on your desktop.
• Create a card.
• Determine a background color.
• Create a border
• Add text.
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1-1.
Open the HyperStudio application. Click twice on the HyperStudio software

application.

1-2.
Determine your skill level. The HyperStudio's

“Home” card appears,
pull down the “Edit
menu” and select
“Preferences.”

In the “Stack
Preferences” box, select
“Presentation” mode.

In “Program
Preferences”, select
“I'm an experienced
HyperStudio user.”
Deselect the other
choices. Click “OK.”

Note: Please remember,
there is a glossary in the
appendix if you have
questions about
definitions related to
this tutorial.



17

Unit II - Creating Projects

1-3.
Start a “New Stack.” Start a “New Stack” by clicking on the

“New Stack” icon.

You can also start a new stack by clicking on
the “Home card” or going to the “File menu”
and selecting “New Stack.”

A dialog box
appears and
asks, “This
launches a
new untitled
stack. Are
you sure you
want to
leave the
Home Stack
now?”
Select,
“Yes.”

1-4.
 Customize the look of your stack. A second prompt appears and asks, “In your

new stack do you want the same card size and
number of colors as in the current stack?”
Select, “No.”

Unit I - Getting Started
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A third dialog box
appears and asks,
“Pick how many
colors you want and
how big you want
your cards to be.” If
256 colors and the
“Standard
HyperStudio Card”
size is selected, press
“OK.” If not, “Pick
how many colors”
you want by placing
your cursor over the
down arrow while
pressing your mouse
button. A pull-down
menu of various
options should
appear. Select 256
colors and let up on
the mouse button. Do
the same for the “Card Size” and select the
option, “Standard HyperStudio Card”, width
512 and height 342.
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1-5.
 Save your stack. You will now

see a blank
white screen
which you will
make a “Title
Card.” Save
your stack by
going to the
“File menu”
and selecting
“Save stack
as.” Use your
name to name
the stack, such
as “John's
stack.” The
area in which to type your name should
already be selected so you can simply type in
the name of your stack.

If not, place your cursor inside the area, drag
over “Untitled”, and begin typing.

Next, click on the “Desktop” button on the
right side of the prompt. This will save your
file to the desktop where it will be easy to
find. Click on “Save.”

Unit I - Getting Started
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1-6.
 Make a tools palette on your desktop. Go to the “Tools menu.”

To make a tools palette which will remain on
your desktop, hold your mousekey down and
drag the tool palette away from the “Menu
bar” and to the side of your screen.

If it overlaps with your card, you can move
your card over by placing your cursor over the
top of the “Title bar”, holding your mouse key
down, and dragging the card to the side.

1-7.
 Create a card and color a background. Select the “paint can” located on the “Tools

palette.”

Go to “Colors menu”  and select a color.

Fill your card with color by placing your
“paint can” pointer over your screen and press
the mouse. Your card will fill with the color
you selected.

If you do not like the color you picked, pull
down the “Edit menu” to “Undo” and repeat
the process.



21

Unit II - Creating Projects

1-8.
 Make a border. Go to the “Options menu”  and select a

“Line size.” The 4th line from the left
is a good size for a border. Click “OK.”

Go to the “Tools palette” and select the
“Square.”

Go to the “Colors palette” and select a
color for the border, a color which is
different from your background.

Position your mouse about a quarter of an
inch from upper left corner of the card.

Drag the mouse diagonally to the right to
about a quarter inch from the lower right.
When you release the mouse, you should have
border around your card.

Unit I - Getting Started
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1-9.
Create a title. Under the “Options menu”, select “Text

Style.” A dialog box appears providing your
with four choices. Of the four options, select
the font “Helvetica”, the style “Bold”, the size
“24”, and  the color “Black.”

Go to the
“Tools
palette” and
select “T” for
“Text.”

Click your
mouse where
you want the
beginning of
your title to be
and type “My
First Stack.”

Warning:
Before you
move your
cursor to go
elsewhere,
double check
the spelling of
the title. If
you have
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misspelled a word, backup by pressing the
“Delete key.” Once you have placed your
cursor elsewhere, you can not edit your
text.

If by some chance you move your cursor
too early, then select the “Editing tool” in
the upper left hand corner of the “Tools
palette” (it looks like a box with dashed
lines), drag the editing tool over an area of
solid color, and drag the selected area over
the misspelled text. Let up your mouse and
begin again.

1-10.
Center your title. Go to the “Tools palette” and select the

“Editing” box to the left of the lasso.

Click to the upper left of “My First Stack”
and drag to the lower right. Place your
cursor over the active selection. Your cursor
will change to an icon with four arrows.
Drag and center the text. Click outside the
dotted rectangle.

Unit I - Getting Started
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Lesson 2 In this lesson you will create a card containing a colored background that

includes clip art and invisible button that plays a recording of your voice.

(Buttons for navigating will be added in Lesson 4.)

Upon completion of this lesson, you
will be able to:

• Add a second card.
• Import and arrange clip art.
• Create an invisible button.
• Customize the look of your cursor.
• Use the built-in “Tape Player” to record

your voice.
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2-1.
 Make a second card. Under “Edit menu”, select “New Card.”

2-2.
Import a background from
HyperStudio's Clip Art collection. Under the “File menu”, select “Import

Background.” Click on “Open.”

Open “HS Art” and select “Education 2.” The
image will automatically transfer to your second
card. You can tell by looking at the name in the
“title bar.”

Unit I - Getting Started
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Drag and place a “Tools palette” on your
desktop.

To begin cleaning up your new
background, select the “Editing tool”; the
rectangle with the dashed
outline located towards
the upper left side of the
“Tools palette.” Place
your cursor (which
changes to a “crosshair”)
on the upper left hand
corner of the “ABC”
image. Drag the cursor to
the opposite corner. Once
the “ABC” is “selected”
or enclosed by a dotted
rectangle, press the
“Delete” key on your
keyboard. The image
disappears. Repeat with
the remaining images
except the border with
the hearts and the boy
writing on a piece of
paper.
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Move the image of the student to the center of
the screen. Outline the student with the
“Editing tool.” Place the cursor, which has
changed to an icon with four arrows, inside
the active rectangle. Press the button on your
mouse and drag the image to the center of
your screen.

Color the background like you did in Lesson
One using the “paint can” tool and “color
palette.”

2-3.
 Create an invisible button. Under the

“Objects menu”,
select “Add a
button.”

A dialog box
appears called,
“Button
Appearance.”
Pick the third
button on the
lower left.

Deselect “Show
name”, “Show
Icon”, and
“Highlight.”

Unit I - Getting Started
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Click on the middle button, named “Features”,
on the lower right side of the screen. A new
dialog box that appears called “Item
Features.” Make sure the following are
deselected: “Locked”, “Group object”, “Drop
off only”, “Hidden” and “No Click.”

From the pull down menu in the lower left
hand corner, select an icon that looks like a
mouse. Later, as you move your cursor over
the screen, the cursor will change from the
“hand” icon to the “mouse” icon indicating
that the pointer is over a
button.

The “Button Appearance”
dialog reappears. Click on
“OK.”
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A dotted rectangle appears over the center of
the screen. Resize the “invisible” button to
cover the image of the boy. Achieve this by
carefully placing your cursor in the corner of
the active area until the cursor changes into
a diagonal arrow. Stretch the box into the
appropriate size.

Unit I - Getting Started
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2-4.
Record your voice.

Click the mouse outside of the button. A dialog
box will appear titled “Actions.” In the right
hand column, select “Play a sound.” Click
“OK.”

A new screen appears titled “Tape Deck.” Click
on the “Record button” and speak into your
microphone and say, “The student is writing a
story.” Click on “Stop” when you are finished
speaking.  Press “Play” to check the recording.
Re-record if you are not satisfied.
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Name the sound and label it with your name, for
example, “sound #1 - Kim.” Click “OK.” Store
the sound in “the stack.” Click “OK.”

Your screen returns to the previous “Actions”
dialog box. Click “Done.”

Under the “File menu”, “Save” your stack.

Unit I - Getting Started
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  Lesson 3 In this lesson you will create a card using the background from the previous

card, import a QuickTime movie, and make a scrolling text box. (Buttons for

navigating will be added in Lesson 4.)

Upon completion of this module, you
will be able to:

• Create a third card.
• Incorporate an existing background.
• Create a visible button.
• Name a button that you see on the screen.
• Set the button to highlight when pressed.
• Import and position a movie on the screen.
• Add a colored scrolling text block.
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3-1.
Create a third card with an
identical background as the
previous card and modify it. Under the “Edit

menu”, drag your
cursor down to
“Ready Made Cards”
and over to your right
to “Same
background.” Note
that the title bar on
your screen has
changed from card 2
to card 3.

Create a floating
“Tools palette.”  (See
Lesson One.)

Using the “Editing
tool”, delete the image
of the student.

Using the “Line tool”,
divide the foreground
in half.  Use the “paint
can” to color the left
side with a darker
color. (See Lesson 1.)

Unit I - Getting Started
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3-2.
Add and name a visible button that
highlights when pressed and plays a
QuickTime movie. Go to “Objects menu” and “Add a button.” A

dialog box will appear called, “Button
Appearance.” Select any of the top four
buttons. Also select “Show name” and
“Highlight” in the lower left hand corner. On
the right side, select colors for the button's
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name and background. Name the button
“Show Movie.” Click “OK.”

The “Actions” dialog box will appear. Select
“Play a movie or video ....”

A “Video/Movie Source” prompt will appear
and ask, “Where do you want to get your
movie?” Select from the “Disk file.” Click
“OK.”
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Reposition and resize the button that appears
on the screen. Click off the active area.

A third prompt appears with a list of
QuickTime movies. Select “Heat.” Click
“Open.”
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Position the movie on the upper
left hand side of the card. Click
outside the active box.

The dialog box “QuickTime
Movies” appears. Select, “Show

Unit I - Getting Started



38

first frame.” Click “OK.”

The “Actions” dialog box reappears.
Click “Done.”

Click on your new button “Show
Movie”  to view the QuickTime
segment.

3-3.
 Add scrolling text. Open the “Object menu” and select

“Add a Text Object.”

Place your cursor on the active box
and drag the text box to the right side
of the window. Resize the text box so
it fits the right half of your screen.
Click off the active text box.

A dialog box appears called “Text
Appearance.” Change the style of the
type if you like. Name the text
“Travel Story” (You can only type 15
letter into this space). Select a text
color and background. Click on
“Draw scroll box”, “scrollable”, and
“draw frame.” Click “OK.”
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You will see a flashing cursor in the
“Textbox.” Type your name and where you
are from. Have fun and invent a story, writing
about a place you've (imaginarily) visited
incorporating a description of the movie. For
example, “I was visiting relatives in Florida
when I meet a group of musicians ...” and
continue the story.

When you are finished, open the
“File menu”  and “Save” your
file.

Unit I - Getting Started
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Lesson 4 In this lesson you will create buttons which will allow you to navigate back

and forth from card to card.

Upon completion of this module, you will be able to:

• Select an appropriate icon for your button.
• Customize your button's color and size.
• Create a button which will highlight when pressed.
• Select a transition from card to card.
• Become familiar with HyperStudio's Browse mode.
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4-1.
Create a customized button which will
take you to the next card. When you have finished creating your third card, open the “Move menu” and select “First

Card.”

After the first card appears, open the “Objects menu” and select “Add a Button.” The “Button
Appearance” dialog box appears. Deselect “Show name” and “Show Icon.” Select
“Highlight.” Click on the “Icons” button.

Unit I - Getting Started
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After the “Icons” dialog box appears, scroll
down and select an icon of an arrow pointing
to the right. Also check to see that the
“Samples” button is selected. Click on “OK.”

The “Button Appearance” prompt reappears.
Select the color of your new button's
background.  Click on “OK.”

Position and resize the “Right arrow” in the
lower right corner. Click outside the button.
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The “Actions” dialog box appears. Under the
“Places to go”, select “Next Card.”

The “Transitions” dialog box appears. Select a
“Transition” and a “Speed.” Click on “Try it.”
When you have found a transition and speed
you like, select “OK.”

When the “Actions” prompt
reappears, click “Done.”

Unit I - Getting Started
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4-2.
Create an identical button and copy
it onto another card. Create a floating “Tools  palette” and select the

“Button” and on the second row from the top,
first icon on the left side.

Click once on the “Forward button” you've just
created. Under the “Edit menu” menu, select
“Copy button.”

Go to the “Tools palette” and select the
“Hand/browse” tool on the upper left.
With your cursor, press the “Forward
button” and proceed to the second card.

Open the “Edit menu” and select “paste
button.”

4-3.
Create a button which will
 take you back to the previous card. Repeat the previous steps. When you are

finished, your should have four new
buttons in your stack; a forward button
on your first card, one forward and one
“previous” button on the second card,
and on “previous” button on the third
card.

Optional: As time permits, open and explore existing HyperStudio stacks.
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Lesson 5 In this lesson you will create a stack consisting of two cards illustrating a

topic related to the Wastewater industry.

Unit I - Getting Started

Upon completion of this lesson, you will
be able to:

• Use the “Erase background” function.
• Integrate science-related content into a
  stack.
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5-1.
Choose a topic. Select one of the topics below. As you choose, keep in  mind that you will be creating two

cards based on this topic. One card will illustrate what you know about the subject (or at
least, one aspect of what you know about the subject). The other card will illustrate a
question you still have (or what you would like to know more about) concerning the topic.
• The food chain process at the microbe level in either a pond or treatment plant.
• A general term that may have a new meaning in a science class, i.e., culture, solution, etc.
• The importance of washing your hands frequently.
• Human population growth and its effect on a wastewater treatment plant.
• Maps and their role in the Wastewater industry.
• Ways to conserve water in a household or industrial setting.

5-2.
Create a card using the “erase
background” function and illustrate
what you know about the topic. Click on “New Stack” on the lower left side of the HyperStudio Home Card. Go to “Edit

menu”, select “erase background”, and choose the color of your choice. Drag the tool and
color palettes to your desktop so that they will always be handy.

Double click on the “T” (for text) on the tool palette and choose Helvetica, Bold, 18 pt.
Choose black or a color with good contrast to the background color of your card. Type the
name of the topic you have chosen. Double click on the text tool again, choose Helvetica,
plan, 14pt, and write a short explanation of what you know about your topic. Use the tool and
color palettes to decorate your card.

`
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5-3.
Make a second card; illustrate a question. Under the “Edit menu”, select “New Card”. Select “Erase Background” as you did earlier

and choose a new color. Also repeat the steps using the text tool, but this time type a sen-
tence using the idiomatic expression. Once again, decorate this card.

5-4.
Add a button to card 1 for navigation.  Select “Move” on the menu bar and select “First Card”. Choose “Add a Button” from the

“Objects menu.”  Select the invisible button (third down on left). Click on “Show Icon”
only. Choose a button style. Click “OK.”

Move your button to the location you desire by putting the mouse arrow inside the moving
dashed lines. Click anywhere outside of the button area when you are happy with its place-
ment. Click “OK.”

When you see the “Button Actions” screen, choose “Next Card” under “PIaces to Go.”
Click on “PIay a Sound” under the “Things to Do” menu and choose a sound from the
screen, text file (under HS Sounds), or record your own. Then click “Done” on the lower
right portion of the screen.

Remember “Transitions” are simply fun ways of going from one card to the next. Try a few
using the “Try It” button, or try them all if you like. Choose one and then click on “Done.”
Now try your button!

5-5.
Add a button to card 2 for navigation. Repeat the activities for making a button on card 2, only choose “Previous Card” on the

Button “Actions” screen. This creates a “loop” as a means of exiting your last card.

Unit I - Getting Started
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5-6.
Save and show! Save your stack. Prepare to show and share the presentation with the rest of the class.

Summary HyperStudio can help you organize, manage retrieve, and present information. In Unit 1 you
learned how to start a HyperStudio document. More specifically, you learned how to use
buttons and menu choices to move from card to card; how to automate browsing by clicking
on the button that symbolizes browsing; make changes in your stack by switching to the
pointer tool; how to add and modify information on cards.

Review questions 1. Did you have any problems creating the stacks in Unit 1?

2. What was the objective of your projects?

3. Was the information or content within the project you created presented in a logical,
easy-to-understand order?

4. Was your topic suitable for the audience you presented your project to?

5. What new skills did you learn from Unit 1?

6. What would you differently if you were to repeat the assignments?

7.  How might you go about creating a larger or more complex project?
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Notes:
Unit I - Getting Started



50



51

Unit II - Creating Projects

Notes:
Unit 2:
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Unit Two “Advanced Organizer”

Throughout the lessons in Unit 1 you became familiar with HyperStudio's interface by
learning how to create a stack with buttons for navigating.

Unit 2 builds upon the previous lessons in Unit 1 enabling you to gain a higher level of
expertise with HyperStudio. The second unit focuses on the special effects you can achieve
using “New Button Actions.”

Please refer to previous lessons for procedures already covered in Unit One. Most of the new
concepts that are introduced in Unit 2 will have accompanying illustrations.



53

Unit II - Creating Projects

Lesson 6 In this lesson you will create a stack of two cards which utilize five kinds of

interactive buttons.

6-1.
Create a title card with a border and
 title.

Click on “New Stack” on the bottom left
side of the Home Card. Save and name your
 project “My First Task.” Click on “OK”
 then go to “Erase Background” under the
 “Edit menu.” Select a color. Go to the
 “Options” menu and select “Line size.”
 Choose the thickest line. Drag the “tools”
 palette to your desktop. Also drag the color
 palette to your desktop. Do this in the same
 manner as you use with the “Tools” palette.
 Choose Black.  Select the “rectangle”
tool above the “T.” Draw a border. Position
your mouse in the upper left area about one
 half inch from the top and side of the card.
 Drag the mouse to the lower right corner
and make a rectangle.

Upon completion of this lesson, you will
be able to:
• Add selective portions of clip art with the
 freehand lasso tool.

• Convert clip art to a button.
• Import text to a scrolling field from an
 existing text file.
• Create a hypertext link.

• Use the “Map tool” to create a button.
• Create an “Exit” button.
• Create computerized speech.
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6-2.
Create a title for your first card
 and enhance it with clipart. Double click on the “Text

tool.” Choose any font you
like and make it bold, point
size 18. Go to the “Options
menu” and select “Text
Color.” Choose black and then
click “OK.” Position the
cursor about an inch from the
left and top. Type “Animals in
Africa.” If it is not centered
on the card, go to the “Tools
palette” and select the “Editing tool” which is next to the
circular lasso. Surround the text with the box and position it
in the center. Repeat the process by writing your name
below the title.

To add clip art: Select “Add Clip Art” under the “File
menu.” Choose disk file “HS Art” and open “Animals.” Use
the lasso to circle the piece of clip art you want to use and
then click on “OK.” Position the artwork by moving it with
the mouse. When you are satisfied with its position, click
outside of the artwork.
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6-3.
Create card 2, import a background and
create an invisible button with sound. Go to “Edit” and select “New Card.” Go to the File

menu and select “Import Background.” Under “HS
Art”, choose the file called “Animals.” The card will
fill with the picture. Go to “Objects” and “Add a
Button.” Select “Invisible” which is the third one
down on the left. Deselect “Show Name”, “Show
Icon” and “Highlight” and then click “OK.” Position
the button over the elephant and click outside the
active area. Select “Play a Sound.” At the “Tape
Deck” prompt, select from the “Disk Library.” It's located under “HS Sounds.” Choose
“Elephant” and then click “OK.” Click on “Done.” Test your button. With your pointer, click
on the arrow tool and watch an outline appear around the button. Move the button to see that
your clip art is unaffected. Move the activated area back in place. Click off the button.
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6-4.
Turn a piece of clip art into a button. On the “Tools palette”, select the “Editing tool” and surround the chimpanzee. Open

“Objects”, select “Add a graphic object.” A  prompt appears “Do you want to turn the
selected part of the screen into a graphic object?” Click “Yes.”

At the prompt “Graphic Appearance”, name the object “Chimp.” To the left side of the
screen, under “Places to Go”, select “Next card.” Choose a “Transition”, click “OK.” Click
“Done.” Place your cursor over the image of the chimp and drag it slightly to see that you've
turned it  an object.

6-5.
Import text into a scrolling text field and
create a hypertext link. Under the “Edit menu”, select “New card.” Color the background. Under “Objects”, select

“Add a Text Object.” Resize it to fill the screen more. Click off. Select “Draw scroll bar”,
“Scrollable” and “Draw frame.” Name the text box “About Addy” We'll pretend the chimp's
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is a pet and it has been named “Addy.” Select color for the text and background. Click on the
“Style” button. Change the text to 14 pt. In the upper right hand corner, press on the button
“Get File.” Open the folder “HS Text” and select “Addy's Poem.” Click “OK.” If you need
to, with the arrow cursor, click once inside the box and resize it so the poem fits well.

In the Browse mode, scroll down until you see the last line. Switch to your text tool and
highlight the words “follow Addy” and change the color of the highlighted text. Under
“Objects”, select “Hypertext Links”, type “Chimp” in the box at the bottom of the prompt
“Hypertext Links.” Click on “Add link.” The remaining four buttons on the right become
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active. Select
“Action.” Under
“Place to go”,
select “Previous
card.” Select a
“Transition.”
Click “Done.”
Click “Done”
again.

6-7.
Convert a selected area to a button
using the “Map” tool. Under the “Objects

menu”, select “Add a
Button.” Highlight the
“map” button on the
lower right side. Click
the button below it,
“Position.” Place your
cursor over a country
and click one. Click
“OK” at the prompt
“Your button's shape has been defined.” Click
“OK.” Be sure “None of the above ” is selected
under “Places to Go.” To the right side under
“Things to Do” select “New Button Actions.” A
“New Button Actions” prompt appears. Select
“Blabbermouth” on the left. Click on the button
below, “Use this NBA.” Type in the text field,
“Many African countries have taken steps to save
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their rich wildlife heritage.” Select a voice,
click on the “Try It” to test it. Click “OK.”
Click “OK” again. Click “Done.” Once your
back to “card 2”, test your new button.

6-8.
Convert a selected area to a button
using the “Freehand” tool. Use the freehand button tool. Under “Objects”,

select “Add a button.” Select the freehand tool
on the lower right. Click “Position.” Circle the
parrot. The prompt will appear, “Your button's
shape has been defined.” Click “OK.” Indicate
this button should return to the previous card.
Click “OK.” Test your button.

On “Card 1”, repeat the steps you just per-
formed except indicate on the first card's parrot
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that the card should go to the “Next card.”

6-9.
Create an exit button. Under “Objects”, select “Add a button.” Choose

the freehand tool. Position by drawing around
the lion. Click “OK.” Click “OK” to return back
to the “Actions” screen. Select “New Button
Actions.” Under “Names” scroll down and select
“MenuChooser.” Click on the button below,



61

Unit II - Creating Projects

“Use this “NBA.” Type “File, Quit
HyperStudio.” Click “OK”, Open the “Icons”
button, select the icon that looks like an exit
sign. Click on “Actions”, and select “Play a
sound.” At the “Tape Deck” prompt, select
“Disk library” an select the sound “Lion”,
“Open” and click “OK”, then “Done.”

As time permits, review lesson 2-3 and modify each button in this project so
the pointer changes as it passes over the button.
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Suggestion/optional: Build upon the previous lessons and form into teams, dividing tasks and creating a project

based on instructional design criteria designated for multimedia products. (See Appendix 4, Principles of Design.)

Benefits:
• To gain experience working in groups and learning from each other.
• To gain more practice and a higher level of skills with the HyperStudio application.
• To gain insight into multimedia production and management of larger or more complex projects.

• Narration included in presentation
• Principles of Design applied

(See Appendix 4).

Suggested sequence of team activity:

1. Form a cooperative team.

2. Brainstorm story ideas.

3. Define goals and gather information.

4. Divide the project into tasks and set

deadlines.

5. Script a storyboard diagram on paper.

6. Design a consistent screen

background or template.

7. Create graphics, text and navigation.

8. Put it all together.

Tasks:
1. Choose a topic related to wastewater.

Obtain approval for the topic.

2. Choose people from your group to fill the
following responsibilities:
a. Programmer- knows how to use

HyperStudio well.
b. Artist- has knowledge of colors and

artistic relationships; can draw with
the mouse and tools.

c. Writer- has good ability to communi
cate through writing; high ability in
grammar and style.

d. Subject-Matter Expert- has ability to
use the library and Internet to locate
needed materials.

3. Work schedule: approximately 4-6 hours.

4. Specifications for Grading (minimum):
• Eight cards plus a title card and credits

card
• Importation of original text and pictures
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Summary In Unit 1 and Unit 2 you learned everything you need to know to begin authoring your own
stacks. HyperStudio lets you add, change, and delete cards; customize your card's
appearance with the paint tools; add information integrating a variety of media. You also
learned how to copy any button from any card to another card allowing you to organize and
link information in a way that is most useful to you.

Review questions 1. How did the objective(s) of your project in Unit 2 differ from Unit 1?

2. Did you have any problems creating the project in Unit 2?

3. What new skills did you learn in Unit 2?

4. What would you differently if you were to repeat the assignment?

5. Since the production of a project can be time consuming, how might you go about
streamlining the process?

6. What would you like to learn next related to the creation of a HyperStudio project?
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Notes:
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Appendix
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Appendix 1: Reading and Browsing
There are many sites on the Internet worth visiting related to the type of instruction illustrated in this mini-course. To begin, we
recommend a Web search using keywords of topics you are interested in or visiting the sites we have recommended below.

Multimedia: http://www.hyperstudio.com
Description: Discover the newest HyperStudio developments, software updates, lots of
sample projects, and more.

ESL: http://www.aitech.ac.jp/~iteslj/
Description: The Inernet TESL Journal -- resources for ESL/EFL students and teachers,
including links to additonal web sites and electronic publications.

Water Science: http://www.wef.org/WefStudents/Teachers/index.htm
Description: An educational section on theWater Environment Federation's Web site
provides complementary activities, glossaries, and materials covering today's most important
water environment topics. Their link to Wastewater Treatment, for grades 6-8, is well
designed and especially relevant to this tutorial or a tour of a treatment plant.
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Appendix 2: Suggested workshop schedule*
Workshop Description: Those enrolled in this course will begin to learn how to use multimedia in their classrooms for teacher-directed
and student-centered activities with HyperStudio. Students will perform tasks intended to help them learn the application and create their
own short programs.

DAY ONE

8:00-9:00 _________ Introduction: This introduction explains what you'll cover in this mini-course, why HyperStudio was

created, what it is, and how to use the applications basic features. A pre-test will be given.

9:00-10:30 _________ Unit #1: You'll go through the tutorial and get a chance to explore HyperStudio on your own.

10:30-10:45 _________ BREAK

10:45-12:00 _________ Completion of the tutorial and student experimentation.

12:00-1 :00 _________ LUNCH

1 :00-2:30 _________ Unit #2: Apply what you've already learned to author your own stack(s). You'll take a look at more

advanced techniques with buttons.

2:30-2:45 _________ BREAK

2:45-4:00 _________ Presentation of projects and assessment of projects and workshop.

* This schedule could be easily spread over a couple of days. Decide what is best in your situation and the age level you are addressing.

Appendix
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Appendix 3: Glossary

Active area ____ An area that you have selected with one of your lasso tools which you can then alter.
Application ____ A set of instructions describing actions for a computer to perform to accomplish a task, conforming to rules of

a particular programming language. Computer programs are sometimes called “software.” Applications are
more sometimes referred to as “programs.”

Authoring ____ Creating or modifying buttons, links, fields, cards, backgrounds, and stacks using the button tools and com-
mands in the Objects menu.

Background ____ A solid color, gradient, pattern, or picture file that covers the entire screen behind all other objects.
Browse ____ To explore HyperStudio by clicking buttons and using the Go menu.

Browse tool ____ The tool which looks like a hand that you use to click buttons.
Button ____ An object drawn with the Button tool or from the Objects menu usually resembling a pushbutton. Buttons are

designed to have interactivity added to them such as designating, confirming, or canceling an action.
Card ____ A type of HyperStudio object; a rectangular area that can hold buttons, fields, and graphics. All cards in a stack

are the same size.
Click ____ Press the button on your mouse.

Clip art ____ Electronic pictures that you can copy form one stack or document and paste into another stack. The term comes
from the use of scissors to clip pictures on paper.

Color palette ____ The palette that you can “tear off” from the color menu.
Color scheme ____ A basic set of colors balanced to provide a consistent and unified look to your presentation.

Command ____ An instruction that causes the computer to perform some action. Commands can be issued by the user through
a mouse device or by keyboard commands.

Cursor ____ The “I” shape that the pointer assumes when your drag over text.
Dialog Box ____ A message window or prompt that appears with either a question and /or instructions.

Drag ____ See “Highlight.”
Field ____  A rectangular area in which you type text.
File ____ An named collection of data created by application and stored on a disk.

Font ____ A complete set of characters for one typeface; for example, Helvetica.
Graphics ____ An image such as a photograph, chart or clip art.
Highlight ____ To select text by dragging the pointer over it. The highlighted text will be affected by your next action.
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“Home” card ____ Usually the first card in a  stack which acts as a Title page or Table of Contents to the rest of the cards and
stacks.

Interactivity ____ The ability to cause the presentation to switch to a different card or perform some other action such as playing
a sound based on input from the user. For example, clicking the mouse button on an object may cause a sound
to play.

Layer ____ Each card is a composite of layers: the background layer, such as a picture or subtle design, and the foreground
layer, with objects such as buttons, fields and graphics on top of the background.

Link ____ Usually in a button, an instruction that allows you, for example, to move from card to card.
Message window ____ A message window or prompt that appears with either a question and /or instructions.

Menu Bar ____ The row of menu names that appears at the top of the presentation window.
Object ____ Anything found on the screen overlaying the background such as text, an image, a button, etc.
Palette ____ A small window that displays icons or patterns you can select by clicking, such as the “Tools palette” or the

“Color palette.”
Pointer tool ____ The tool used most often to select and manipulate text and graphics.
Preferences ____ A command on the File menu that you can use to control default settings.

Program ____ A set of instructions describing actions for a computer to perform to accomplish a task, conforming to rules of
a particular programming language. Computer programs are sometimes called “software.” Programs are more
sometimes referred to as “applications.”

Programmer ____ The person most responsible for creating a set of instructions describing the actions for a computer or applica-
tion to perform.

Prompt ____  A message window or dialog box that appears with either a question and /or instructions.
QuickTime ____ An extension program that allows the computer to move and play data with the integration of sound, video, and

animation.
Stack ____ A collection of HyperStudio cards.

Storyboard ____ A written and drawn visualization the completed presentation. Usually used for planning purposes.
Subject-matter expert ____ A person, such as an instructor or researcher, that has the most responsibility and influence on the presentation’s

content.
Template ____ A presentation whose screen format and color scheme you apply from card to card.
Title Bar ____ The stripped bar at the top of your window that indicates the name of the project you are working on.

Tools Palette ____ The palette that you can “tear off” the Tools menu
Transitions ____ The effects that move one card off the screen and the next card on.

User ____ A person who utilizes a computer program as a reference or to perform a function.
Window ____ An area on the computer screen that displays information.
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Consistent color scheme used throughout.

Color used to draw attention to what is most important.

Background doesn't overpower the foreground.

Consistent style of type used throughout.

Limit of 2-5 objects per page.

User Interface

Multi-sensory integration of a variety of media.

Buttons are alike, correct and placed consistently.

Each card has a way to exit.

Content is relevant to audience.

Objectives and summary included in program.

Images relevant to content.

Program delightfully engages the user.

Appendix 4: Principles of Design

Visual Appeal Needs More Attention Overdone/Distracting Just Right
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1.1
Purpose of

HyperStudio.

1.3
Use of HyperStudio.

1.2
Importance of
HyperStudio.

1.
What HyperStudio is.

1.1.1
Student will be able to
describe HyperStudio
to others.

1.2.1
Student will be able to
describe who uses it.

1.2.2
Student will be able to
explain its benefits.

Level III
Behavioral
Objectives

Level I
Application

Classification

Level II
Application
Components

1.3.1
Student will be able to
identify basic features of
HyperStudio's interface.

1.3.2
Student will be able to
identify the basic steps
needed to create a
HyperStudio stack.

1.3.3
Student will be able to
identify the five advanced
features for creating
interactive buttons.

Appendix 5: Objectives Schematic
Appendix
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